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Trademark Notice

Itron is aregistered trademark of Itron, Inc.

All other product names and logosin thisdocument are used for identification purposesonly and may betrademarksor registered
trademarks of their respective companies.

Copyright Notice

Your company hastheright to reproduce this contract document provided that such reproduction shall be subject to the same use
and disclosure restrictions contained in the Confidentiality and Non-Disclosure paragraphs in the Sales Contract.

© 2004-2006 Itron, Inc. All rights reserved.

Compliance Statement

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC
Rules. These limits are designed to provide reasonable protection against harmful interferencein aresidential installation. This
equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the
instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not
occur in aparticular installation.

If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the
equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:
Reorient or relocate the receiving antenna.

Increase the separation between the equipment and receiver.

Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.

Consult the dealer or an experienced radio or TV technician for help.

Thisdevice complieswith Subpart C of Part 15 of FCC Rules. Operation of thisdeviceis subject to thefollowing two conditions:
¢ Thisdevice may not cause harmful interference.
¢ Thisdevice must accept any interference that may cause undesirable operation.

This device complies with Part 15.247 of the FCC rules governing spread spectrum devices.

This device must be permanently mounted such that it retains a distance of 20 centimeters (7.9 inches) from all personsin order
to comply with FCC RF exposure levels.

Modification and Repairs

To ensure FCC compliance and system performance, thisdevice, antenna, and coaxial assembly shall not be changed or modified
in any way without the expressed written consent of Itron. Any unauthorized changes or modifications may void the user’s
authority to operate the equipment.

Meter Installation/Removal

In the event of malfunction, all repairs should be performed by Itron. It is the responsibility of users requiring service to report
the need for service to Itron.

& WARNING! Theinstallation of this device may subject the installer to hazardous conditions, including the possibility of
electrical shock. Trained professionals should install this device. Thisinstruction manual should be considered supple-
mental and used in addition to and in accordance with your company’s meter installation and removal procedures and all
related safety regulations.

Customer Service

If you have questions, comments or suggestions contact Itron asfollows:
e Mail: Itron, Inc.; Attention: Customer Care; 2818 N. Sullivan Road; Spokane, WA 99216
« E-mail: support@itron.com
¢ Phone: 1-800-635-8725
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Before You Begin

Overview

Audience

How This Document
is Organized

Documentation
Conventions

This document describes the installation and configuration of repeaters for the
Fixed Network and Mobile Collection solutions. This document describes the
different types of repeaters; available installation kits and accessories; and the
overall installation process.

This document isintended for utility field personnel and others associated with
the installation and maintenance of a repeater. Installers should have previous
training and experience in the following:

» Installation and maintenance of €electric meters
» Electrical wiring and related skills
» All utility-specific OSHA regulations and procedures

This document is organized as the following.

Chapter Description

List of Procedures Provides an aphabetical list of all procedures con-
tained in this document.

Chapter 1. Describeswhat arepeater is, thetypes of repeaters,

Getting Sarted specifications, and the contents of installation kits.

Chapter 2. Provides step-by-step instructions for installing

Sngle-Channel single-channel pole-mount and sleeve-mount

Repeater Installation repeaters.

Chapter 3. Eight- Provides step-by-step instructions for installing

Channel Repeater eight-channel pole-mount and decorative-mount

Installation repeaters.

This document uses the following conventions.

Convention Example
Keypresses are in bold. Press Enter when compl ete.
Menu paths are in bold. From the Start menu, choose File > Save As.

(This example instructs the user to choose File
from the Sart menu; then choose Save As from
the File menu.)

Before You Begin
TDC-0613-004e 06/06
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Convention Example

Computer commandstobe At the C: prompt, type cd itron/bin
typed by the user arein
Courier New font.

Filenamesareincourier Thedatais uploaded to the upiload.dat file
New font.

Hypertext linksareblue. ~ See Contents on page iii for the complete table
of contents.

Thelast linein atableis Note the thick gray line below this row. If the
defined by athick gray table continues on another page, the column
line. headings are repeated on each page.

CAUTION Thistype of note warnsthe user that failure to heed theinformation in
the note could result in loss of data. Be sure to carefully read a CAUTION note
and heed the advice/instructions.

WARNING! Thistype of noteisused to warn of potentia physical harm
to the user or hardware. It is critical that you pay strict attention to
WARNING notes, read the information carefully, and heed the
advice/instructions.

viii Repeater Installation Guide
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Chapter 1
Getting Started

What is a Repeater?

Overview

Repeaters in a Fixed
Network
Environment

Repeaters in a
Mobile Collection
Environment

Repeater
Identification

The repeater is a network component that collects data from nearby endpoints
and forwards data to a collection device, such as a cell control unit (for Fixed
Network applications) or a Mobile Collector radio (for Mobile Collection appli-
cations).

WARNING! Single-channel repeaters are not compatible with high-
powered devices (such as CENTRON R300, 60W, and high-power gas
endpoints).

Thistype of repeater expands the footprint of devices by forwarding data
between endpoints and the CCU. Single-channel repeaters forward both
standard consumption messages (SCM) and interval data messages (IDM), and
eight-channel repeaters forward SCM, IDM, and Type 25 packets (which are
used to indicate positive outage notifications and restorations).

The CCU then communicates the data to the Fixed Network Collection Engine.
The CCU opens communication sessions at regular intervals, listening for data
from the network repeaters. The CCU then processes returned data according to
the default or custom parameters configured at the Collection Engine for each
meter. Repeaters communicate with ERT endpoints and the CCU in the 900
MHz radio band.

Thistype of single-channel repeater hel ps expand the service areafor Mobile
Collection Systems. These repeaters support situations where endpoint readings
aredifficult to acquire from the vehicle, such asfrom endpoints located in meter
vaults, rooms below ground, or above street level in apartments or commercia
buildings. The repeater collects data from bubble-up endpoints and passes the
datato the Mobile Collector radio. This repeater isamodified version of the
Fixed Network repeater, incorporating awider | F band which allowsthe Mobile
Collector radio to hear transmission. Mobile Collection repeaters are intended
for usein an indoor environment only.

Each repeater has a unique identification number stored initsinterna flash
memory. The ID number is used for remote unit communications, setting the
timing for acknowledgements, setting the index into the transmit, receiving hop
tables at power up, setting the random sequences in the transmit hop table, and
other functions. A repeater does not track other repeaters within its communi-
cation range.

Chapter 1 - Getting Started
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What is a Repeater?

Repeater Types Itron offerstwo types of repeaters: single-channel and eight-channel. Each type
of repeater can be installed multiple ways.

Thetype of repeater you install will depend on your site characteristics and
network needs. See Planning for Repeater Installations on page 8 for more
information.

To learn how to install these types of repeaters, see:
» Chapter 2, “Single-Channel Repeater Installation” on page 11
» Chapter 3, “Eight-Channel Repeater Installation” on page 27

Repeater Thefollowing table showswhich repeater types and installations are compatible
Compatibility Matrix  with Fixed Network and Mobile Collection solutions.
Solution
Installation Type Fixed Network Mobile Collection

Pole-mount (single- and
eight-channel)

Sleeve-mount (ringed
and ringless)

V. g
V. g

Wall-mount (single-
channel)

Decorative-mount
(eight-channel)

RLLR

2 Repeater Installation Guide
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What is a Repeater?

Repeater Each repeater type (single-channel or eight-channel) and installation option

Specifications (pole-, sleeve-, wall-, or decorative-mount) has slightly different specifications.
See the tables below for a description of each type of repeater and installation
option.

Single-Channel Pole-Mount Repeater

Thefollowing table lists the physical specifications for the single-channel, pole-
mount repeater.

Pole-Mount Repeater Specification Description

Power Source Single-phase 240V or 120V AC

Operating Temperature -40t0+75C

Storage Temperature -40t0+85C

Operating humidity 5 to 95% non-condensing relative
humidity

Product identification Numeric and bar coded repeater
module serial number

ANSI Compliance C12.1 standards

Receive/Transmit Frequency Range  908-924 MHz

Data I ntegrity Verified in every data message

Chapter 1 - Getting Started
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{ What is a Repeater?

4 Repeater Installation Guide
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Single-Channel Sleeve Mount Repeater

repeater.

Sleeve-Mount Repeater Specification

Power Source

The following table lists specifications for the single-channel, sleeve-mount

Description
Single-phase 240V or 120V AC

Operating Temperature

-40to+75C

Storage Temperature -40t0+85C

Operating humidity 5 to 95% non-condensing relative
humidity

Product identification Numeric and bar coded repeater
module serial number

ANSI Compliance C12.1 standards

Receive/Transmit Frequency Range  908-924 MHz

Data I ntegrity

Verified in every data message

Meter Form Factor

2S 240V 3-wire Class 200
1S 120V 2-wire Class 100

Meter Sleeve Mount

S, I5S

DRAFT
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Single-Channel Wall Mount Repeater

What is a Repeater? {

The following table lists specifications for the single-channel, wall-mount

repeater.

Sleeve-Mount Repeater Specification  Description

Power Source Single-phase 240V or 120V AC

Operating Temperature -40t0+75C

Storage Temperature -40to+85C

Operating humidity 5 to 95% non-condensing relative
humidity

Product identification Numeric and bar coded repeater
module serial number

ANSI Compliance C12.1 standards

Receive/Transmit Frequency Range  908-924 MHz

Data I ntegrity

Verified in every data message

Meter Form Factor

2S 240V 3-wire Class 200
1S 120V 2-wire Class 100

Meter Sleeve Mount

S, BS

Chapter 1 - Getting Started 5
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What is a Repeater?
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Eight-Channel Pole-Mount Repeater

The following table lists specifications for the eight-channel, pole-mount

repeater.

Sleeve-Mount Repeater Specification

Power Source

Description
Single-phase 240V or 120V AC

Operating Temperature

-20to+60 C

Storage Temperature -30to+70C

Operating humidity 5 to 95% non-condensing relative
humidity

Product identification Numeric and bar coded repeater
module serial number

ANSI Compliance C12.1 standards

Receive/Transmit Frequency Range  908-924 MHz

Data I ntegrity

Verified in every data message



What is a Repeater?

Eight-Channel Decorative-Mount Repeater

The following table lists specifications for the eight-channel, decorative-mount

repeater.

NOTE The antenna on the decorative-mount repeater isinterna and cannot be

modified.

Sleeve-Mount Repeater Specification

Power Source

Description
Single-phase 240V or 120V AC

Operating Temperature

-20t0 +60 C

Storage Temperature -30to+70C

Operating humidity 5 to 95% non-condensing relative
humidity

Product identification Numeric and bar coded repeater
module serial number

ANSI Compliance C12.1 standards

Receive/Transmit Frequency Range  908-924 MHz

Data I ntegrity

Verified in every data message

Chapter 1 - Getting Started
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Planning for Repeater Installations

Planning for Repeater Installations

Installation Types NOTE Thefollowing information appliesto repeatersin a Fixed Network envi-
ronment.

A repeater may beinstalled in the field directly on a meter using a meter sleeve,
on a utility pole, or on alamppost or other decorative mount. The type of instal-
lation used affects the radio performance of the repeater. For example, a pole
mounted repeater will have agreater radio coverage areathan a sleeve mounted
repeater.

Select an installation type based on the following criteria:
» Availability of utility poles
» Costsreated to utility pole installation and future maintenance visits.
» Construction materias surrounding the selected meter installation site.
» Aesthetic considerations for development/residential installation.

Unpacking the Repeater

Overview When you remove arepeater from its shipping carton, verify that no damage has
occurred during shipment. Return the repeater to its shipping packaging for
transport to the field. Transporting the repeater without protective packaging
may result in damage.

What'’s In the Box The contents of your repeater carton will vary, depending on the type of repeater
shipped.

Pole-Mount Repeater (Single- and Eight-Channel)
* Pole-mount repeater

* Antenna

IMPORTANT Thisisthe only antennathat is certified for use with this
device. Use of an antenna other than the one supplied will violate FCC
rules, voiding the grant of certification.

» Antenna gasket

* Hex bolts (4)

»  Washers (4)

» Lock washers (4)

» Adjustable mounting bracket kit

NOTE A photoelectric cell power adapter or unterminated power cableis
required to provide power to the repeater; these are available from Itron
and are sold separately.

Sleeve-Mount Repeater (Single-Channel)
» Sleeve-mount repeater

» Antenna, cover and tension band (the antenna and cover are integrated as
one unit)

* Meter sealing ring

8 Repeater Installation Guide
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Wall-Mount Repeater (Single-Channel)
e Wall-mount repeater

* Antenna
» Antenna gasket

Decorative-Mount Repeater (Eight-Channel)
» Decorative-mount repeater

* Rubber seadl

Unpacking the Repeater

Chapter 1 - Getting Started
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Unpacking the Repeater
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Chapter 2

Single-Channel Repeater Installation

Getting Started

Overview Thischapter showsyou how toinstall asingle-channel repeater in thefield. Your
repeater installation process will depend on the type of repeater (pole-mount or
sleeve-mount) and the installation location. For more information, see:

» |nstalling Pole-Mount Repeaters on page 11
» Installing Seeve-Mount Repeaters on page 16
* Installing Wall Mount Repeaters on page 23

Installing Pole-Mount Repeaters

Overview NOTE The following information applies to Fixed Network repeaters.

A pole-mount repeater mounts on a streetlight davit at least 6 inches behind the
lamp, which alows for clearance to change the light bulb in the lamp.

Required Hardware A pole-mount repeater installation requires the following tools and hardware:
and Tools » Adjustable Mounting Kit (part CFG-003-002; this ships with the repeater)

Adjustable Mounting Kit,
unassembled

D R A H- Chapter 2 - Single-Channel Repeater Installation 11
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Installing Pole-Mount Repeaters

Earth Grounding

Wind Load

Installing a Single-
Channel Repeater
on a Davit

Repeater Installation Guide
TDC-0613-004e 06/06

7/16-inch nut driver, wrench, or ratchet-wrench

Inch-pound torque wrench with 7/16-inch and 1/2-inch sockets
1/2-inch wrench

Tie wraps (not supplied with mounting kit)

Depending on thelocal requirementsfor your utility company, you may need to
ground each repeater to earth ground. If you need to earth ground a repeater,
ground the case through one of the mounting screws that attach the repeater to
the pole using agrounding cable in accordance with local utility company guide-
lines. The grounding cableis not supplied by Itron.

Prior toinstalling arepeater on alight pole, ensure that the weight and estimated
project area (EPA) of the repeater does not exceed the wind load and total weight
load of the light pole. The manufacturer of the light pole should provide wind
load and weight rating specifications.

To install arepeater on a street light davit, follow the steps below.

Step

Action

Attach the bottom plate of the mounting kit to the top of the repeater.
For this procedure, use the following items from the Adjustable
Mounting Kit:

* (4) small lock washers

e (4) small flat washers

e (4) 17/8-inch long bolts

e Bottom plate

Attach the adjustable bracket to the bottom plate. Use the following
items from the Adjustable Mounting Kit:

* (2 largelock washers

e (2)largeflat washers

e (2) Y2-inch nuts

* Adjustable bracket

» Bottom plate (attached to repeater)

IMPORTANT Do not completely tighten the nuts yet. The repeater ori-
entation will need to be adjusted once the kit is attached to the davit.

Partially bolt one end of the top plate onto the adjustable bracket of the
mounting kit. L eave the bolt loose so that the bracket can swing. When
you areready to install the repeater initsfinal position, you will swing
the bracket across the top of the davit and secureit. For this procedure,
use the following items from the Adjustable Mounting Kit:

e (1) small lock washer
e (1) flat washer
* (1) 31/4” bolt

Place the antenna gasket over the antenna mount on the repeater.



Installing Pole-Mount Repeaters

Step Action
5  Position the repeater beneath the davit, making sure that:
* The connectors of the repeater face the street lamp.

» The power cable can easily extend between the power connector
at the repeater and the photoel ectric sensor.

» Therepeater isplaced isat least a3 inches from the light fixture.
This alows the casing of the fixture to open completely, pro-
viding maintenance access when necessary.

» Thebottom plate of the mounting kit is straight along the sides of
the repeater lid and is securely attached.

» The groove on the adjustabl e bracket of the mounting kit aligns
with the davit.

» Therepeater hangs straight down.

Top plate

Adjustable
bracket

Bottom
plate

Connectors —

6  Swing the unsecured end of the top plate of the mounting kit over the
davit and partialy bolt it in place. Then torgue both boltsto 40-inch
pounds.

IMPORTANT Thetwo hex bolts must be torqued as specified to achieve
the clamping force needed to withstand 100 MPH. wind. If the boltsare
under-torqued, the necessary clamping force may not be obtained. If
the bolts are over-torqued, the brackets may become overstressed and
clamping force may be reduced.

7 Useavoltmeter to verify that the unit has power. If power is not
present, the repeater will not function. Make any corrections necessary
to provide power before continuing with the installation.

Chapter 2 - Single-Channel Repeater Installation
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Installing Pole-Mount Repeaters

Repeater Installation Guide
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Step Action

8

Provide power to the repeater. This can be done by either using a pho-
toelectric sensor or hard-wiring the repeater with power.

To install the photoel ectric power adapter, use the steps below.
To hard-wire power to the repeater, skip to step 9.

a. Notethe current orientation of the sensor window (usually it faces
north), so that you can restore it to that orientation when you are
done.

b. Remove the photoel ectric sensor.

c. Insert the repeater photoel ectric power adapter into the socket and
turntolock it in place.

d. Re-insert the photoel ectric sensor into the socket on the top of the
power adapter.

e. Adjust the adapter to face the photosensor window to its original
orientation by pulling up on the adapter housing and swiveling
the housing.

f. Plug the power cord into the 5-pin connector on the repeater.

g. Use tie-wraps as necessary to secure the cable away from the
repeater housing.

Photoelectric power adapter

Photoelectric sensor



Installing Pole-Mount Repeaters

Step Action

9

To power the repeater when installing it on a pole without a photo-
electric sensor, you must strip the power cable with wire strippers and
connect theindividual wiresto the 120V/240V and neutral wireson the
pole.

To hard-wire power to the repeater, follow the steps below.

a. Connect the unterminated end of the power cable to the power
source on the pole. The power cable is made up of two colored
wires: black and white. Connect these wires per the items below:

* Black (wire color) - Line side (signal name) - 5 (pin number)
* White (wire color) - Neutral (signal name) 1 (pin number)

b. Wrap any excess cable around the davit or use tie-wraps (not
included) to secure the cable away from the repeater.

¢. Connect the other end of the power cableto the 5-pin connector on
the front of the repeater.

10

Before mounting the antenna, ensure the antenna gasket is seated
properly.
Attach the antenna. Be sure not to cross-thread the antenna when

installing it on the repeater. Attach the antenna on the bottom of the
repeater, tightening with awrench until the antenna makes contact.

TIP  To test whether the antenna makes contact, try to wiggle the
antenna. If it seems loose, continue tightening.

Chapter 2 - Single-Channel Repeater Installation
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Installing Sleeve-Mount Repeaters

Installing Sleeve-Mount Repeaters

Types of Sleeve- NOTE The following information applies to both Fixed Network and Mobile
Mount Repeaters Collection repeaters.

Sleeve-mount repeater installation depends on the type of meter socket.

Meter Socket Type Description

Ringless A ringless mounted meter installs under the meter
box lid, which is hinged at the top of the box.

Ringed A ringed meter installs on the outside of the meter

box and is secured with a meter seal ring.

Repeaters can be installed on both 2S (residential) and 12S (commercial/indus-
trial) meters; the major difference between these types is the number of prongs
used to attach the repeater or meter to the socket (type 2S have four prongs; type
12S have 5 prongs). Ensure that you have the correct type of repeater for your
installation before heading out in the field.

Required Tools The following tools are necessary for sleeve-mount repeater installation:
» Tamper seals and associated meter installation/removal tools.

» Panduit Wave-Ty installation tool (optional). Thistool cuts excess cable
and applies tension to the tension band.

Installing on a A ringless meter socket does not use ameter seal ring between the meter and the
Ringless Meter meter socket. Instead, the meter is secured in the meter socket by alid. To aid
Socket installation on a ringless meter socket, the repeater antenna does not come

attached to the repeater. Attach it to the repeater in the following procedure.
To install arepeater on a ringless meter socket, follow the steps below.

IMPORTANT  Thefollowing instructions should be considered supplemental to
the meter installation and removal procedures for your utility. Follow all appli-
cable procedures and regulations when performing meter installation.

Step Action
1 Remove tamper seals.

2 Verify that the service is compatible with the repeater (2S or 12S). See
Types of Seeve-Mount Repeaters on page 16 for more information.

3 Remove the meter socket lid.

4 Remove the meter from the socket.

16 Repeater Installation Guide
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Installing Sleeve-Mount Repeaters {

Step Action
5  Insert the repeater into the socket.

6  Replace the meter socket lid.

NOTE If needed, trim the breakaway rim on the repester sleeve using
diagonal cuts so that the socket lid will fit over the repesater.

7 Remove the protective label from the double-sided tape on the bottom
of the antenna (the antenna and antenna cover are one unit).

IMPORTANT Be careful to not damage or remove the tape.

D R A H’ Chapter 2 - Single-Channel Repeater Installation 17
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{ Installing Sleeve-Mount Repeaters

Step Action
8  Attach the antennato the top of the Seeve.

IMPORTANT Ensurethat it isattached forward against the shoulder and
centered on the flat area on the top of the sleeve.

Antenna/antenna
cover attached

9  Secure the tension band around the repeater and antenna, pulling to
tighten. Ensure that the back lip of the antennais under the tension
band.

Antenna

(top view) Tension band

10  Tighten the tension band using atension setting tool.

11 Clip off any excess material from the tension band.

12 Snap the meter into the repeater socket.

18 Repeater Installation Guide
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Installing Sleeve-Mount Repeaters {

Step Action

13 Attach and tighten the meter ring, making sure to catch the antenna
cover lip under the ring band.

Antenna
cover lip

Meter ring

14 Install atamper seal in the ring band and on the meter socket lid.

Chapter 2 - Single-Channel Repeater Installation 19
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Installing Sleeve-Mount Repeaters

Installing on a

Ringed Meter Socket

Repeater Installation Guide
TDC-0613-004e 06/06

A ringed meter socket uses ameter sealing ring to secure the meter to the socket.
To install arepeater on aringed meter socket, do the following steps.

Step Action

1

Remove tamper seals.

2 Verify that the service is compatible with the repeater (2S or 12S). See
Types of Seeve-Mount Repeaters on page 16 for more information.

3 Remove the meter seal ring.

4 Pull the meter from the socket.

5  Insert the repeater sleeve into the meter socket.

Repeater

6  Remove the protective label from the double-sided tape on the bottom
of the antenna (the antenna and antenna cover are one unit).
IMPORTANT Be careful to not damage or remove the tape.

7 Attach the antenna/antenna cover unit to the top of the deeve.

IMPORTANT Ensurethat it isattached forward against the shoulder and
centered on the flat area on the top of the sleeve.

Antenna/antenna
cover attached




Installing Sleeve-Mount Repeaters {

Step Action

8  Secure the tension band around the repeater and antenna, pulling to
tighten. Ensure that the back lip of the antenna is under the tension
band.

Antenna
(top view)

Tension band

9  Tighten the tension band using a tension setting tool.

10  Clip off any excess material from the tension band.
11 Secure ameter seal ring between the repeater and the meter socket.

Meter seal ring

12 Insert the meter into the repeater socket.

D R A H’ Chapter 2 - Single-Channel Repeater Installation 21
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Step Action

13 Attach the meter seal ring making sure to catch the antenna cover lip
under the ring band.

[

Catch cover lip
under ring

14  Replace the tamper seals.

22 / Repeater Installation Guide q-
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Installing Wall Mount Repeaters

Overview

Installing a Wall
Mount Repeater

NOTE The following information applies to Fixed Network and Mabile Col-
lection repeaters.

Wall-mount repeaters are typically used in an environment where traditional
reads are difficult to acquire. These repeaters are meant for indoor use in places
like meter vaults or rooms below ground, and should be installed in close prox-
imity to the meter bank they represent.

WARNING! Regulationsdo not allow thistype of single-channel repeater
to be used with CENTRON meters, 60W, and high-power gas endpoints.

To install awall-mount repeater, follow the steps below.

IMPORTANT The following steps are provided as a guideline only. When
installing this type of repeater, power can be supplied avariety of ways; the
repeater can be mounted on multiple surfaces (concrete, wood, and so on); and
installation locations may be varied. Install a wall-mount repeater according to
the standards provided by your company, local codes and regulations, and so on.

Step Action

1 Determinethe ideal mounting location of the repeater. This should be
in close proximity to the meter bank it represents.

2 Using a screwdriver, remove the front plate from the repeater.

Chapter 2 - Single-Channel Repeater Installation
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Installing Wall Mount Repeaters

Step Action

3 Thread the three wires from the inside of the repeater out through the
power supply inlet on the bottom of the repeater.

IMPORTANT Be careful not to disturb the electronics within the
repeater; these critical items are covered by a plastic shield.

4  Reattach the front plate to the repeater.

5  Place the antenna gasket around the antenna base on the top of the
repeater.

6  Attach the antennato the top of the repeater, taking care not to cross-
thread it. Ensure atight seal between the antenna and gasket.

24 Repeater Installation Guide
TDC-0613-004e 06/06



Step

Installing Wall Mount Repeaters /

Action
Attach the repeater to the wall surface.

Depending on the surface, you may need to pre-drill screw holes, attach
lag bolts, and so on.

DRAFT

Provide power to the repeater. This step may be performed by an elec-
trician or other qualified personnel.

There are three wires used to provide power.
*  White = Neutral
» Black = Live (hot)
* Green = Ground

Depending on your installation configuration, you may not need to use
all three.

Chapter 2 - Single-Channel Repeater Installation 25
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Chapter 3
Eight-Channel Repeater Installation

Getting Started

Overview This chapter shows you how to install an eight-channel repeater in the field.
For more information, see:
* Installing Pole-Mount Repeaters on page 27
» Installing Decorative-Mount Repeaters on page 32

Installing Pole-Mount Repeaters

Overview NOTE The following information applies to Fixed Network repeaters.

A pole-mount repeater mounts on a streetlight davit at least 3 inches behind the
lamp, which alows for clearance to change the light bulb in the lamp.

The mounting kit for the repeater will depend on the angle of the davit. If the
angle of thedavit islessthan 15 degrees, the standard bracket kit should be used.
If the angle is greater than 15 degrees, use the adjustable bracket kit.

Required Hardware A pole-mount repeater installation requires the following tools and hardware:
and Tools » Adjustable Mounting Kit (part CFG-003-002; this shipswith the repeater)

Adjustable Mounting Kit, unassembled

D R A H- Chapter 3 - Eight-Channel Repeater Installation 27
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Installing Pole-Mount Repeaters

Earth Grounding

Wind Load

Installing an Eight-
Channel Repeater
on a Davit

Repeater Installation Guide
TDC-0613-004e 06/06

7/16-inch nut driver, wrench, or ratchet-wrench

Inch-pound torque wrench with 7/16-inch and 1/2-inch sockets
1/2-inch wrench

Tie wraps (not supplied with mounting kit)

Depending on thelocal requirementsfor your utility company, you may need to
ground each repeater to earth ground. If you need to earth ground a repeater,
ground the case through one of the mounting screws that attach the repeater to
the pole using agrounding cable in accordance with local utility company guide-
lines. The grounding cableis not supplied by Itron.

Prior toinstalling arepeater on alight pole, ensure that the weight and estimated
project area (EPA) of the repeater does not exceed the wind load and total weight
load of the light pole. The manufacturer of the light pole should provide wind
load and weight rating specifications.

Toinstall an eight-channel repeater on astreet light davit, follow the steps bel ow.

Step

Action

Attach the bottom plate of the mounting kit to the top of the repeater.
For this procedure, use the following items from the Adjustable
Mounting Kit:

* (4) small lock washers

e (4) small flat washers

e (4) 17/8-inch long bolts

e Bottom plate

Attach the adjustable bracket to the bottom plate. Use the following
items from the Adjustable Mounting Kit:

* (2 largelock washers

e (2)largeflat washers

e (2) Y2-inch nuts

* Adjustable bracket

» Bottom plate (attached to repeater)

IMPORTANT Do not completely tighten the nuts yet. The repeater ori-
entation will need to be adjusted once the kit is attached to the davit.

Partially bolt one end of the top plate onto the adjustable bracket of the
mounting kit. L eave the bolt loose so that the bracket can swing. When
you areready to install the repeater initsfinal position, you will swing
the bracket across the top of the davit and secureit. For this procedure,
use the following items from the Adjustable Mounting Kit:

e (1) small lock washer
e (1) flat washer
* (1) 31/4” bolt

Place the antenna gasket over the antenna mount on the repeater.



Installing Pole-Mount Repeaters

Step Action
5  Position the repeater beneath the davit, making sure that:
* The connectors of the repeater face the street lamp.

» The power cable can easily extend between the power connector
at the repeater and the photoel ectric sensor.

» Therepeater isplaced isat least a3 inches from the light fixture.
This alows the casing of the fixture to open completely, pro-
viding maintenance access when necessary.

» Thebottom plate of the mounting kit is straight along the sides of
the repeater lid and is securely attached.

» The groove on the adjustabl e bracket of the mounting kit aligns
with the davit.

» Therepeater hangs straight down.

Top plate

Adjustable
bracket

Bottom
plate

Connectors —

6  Swing the unsecured end of the top plate of the mounting kit over the
davit and partialy bolt it in place. Then torgue both boltsto 40 inch-
pounds.

IMPORTANT Thetwo hex bolts must be torqued as specified to achieve
the clamping force needed to withstand 100 MPH. wind. If the boltsare
under-torqued, the necessary clamping force may not be obtained. If
the bolts are over-torqued, the brackets may become overstressed and
clamping force may be reduced.

7 Useavoltmeter to verify that the unit has power. If power is not
present, the repeater will not function. Make any corrections necessary
to provide power before continuing with the installation.

Chapter 3 - Eight-Channel Repeater Installation
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Installing Pole-Mount Repeaters
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Step Action

8

Provide power to the repeater. This can be done by either using a pho-
toelectric sensor or hard-wiring the repeater with power.

To install the photoel ectric power adapter, use the steps below.
To hard-wire power to the repeater, skip to step 9.

a. Notethe current orientation of the sensor window (usually it faces
north), so that you can restore it to that orientation when you are
done.

b. Remove the photoel ectric sensor.

c. Insert the repeater photoel ectric power adapter into the socket and
turntolock it in place.

d. Re-insert the photoel ectric sensor into the socket on the top of the
power adapter.

e. Adjust the adapter to face the photosensor window to its original
orientation by pulling up on the adapter housing and swiveling
the housing.

f. Plug the power cord into the 5-pin connector on the repeater.

g. Use tie-wraps as necessary to secure the cable away from the
repeater housing.

Photoelectric power adapter

Photoelectric sensor



Installing Pole-Mount Repeaters

Step Action

9

To power the repeater when installing it on a pole without a photo-
electric sensor, you must strip the power cable with wire strippers and
connect theindividual wiresto the 120V/240V and neutral wireson the
pole.

To hard-wire power to the repeater, follow the steps below.

a. Connect the unterminated end of the power cable to the power
source on the pole. The power cable is made up of two colored
wires: black and white. Connect these wires per the items below:

* Black (wire color) - Line side (signal name) - 5 (pin number)
* White (wire color) - Neutral (signal name) 1 (pin number)

b. Wrap any excess cable around the davit or use tie-wraps (not
included) to secure the cable away from the repeater.

¢. Connect the other end of the power cableto the 5-pin connector on
the front of the repeater.

10

Before mounting the antenna, ensure the antenna gasket is seated
properly.
Attach the antenna. Be sure not to cross-thread the antenna when

installing it on the repeater. Attach the antenna on the bottom of the
repeater, tightening with awrench until the antenna makes contact.

TIP  To test whether the antenna makes contact, try to wiggle the
antenna. If it seems loose, continue tightening.

Chapter 3 - Eight-Channel Repeater Installation
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Installing Decorative-Mount Repeaters

Installing Decorative-Mount Repeaters

Overview NOTE The following information applies to Fixed Network repeaters.

Decorative-mount repeaters are designed to “blend in” more with their sur-
roundings. These repeaters are typically installed in developments, residential
areas, or other areas where an emphasisis placed on the appearance of the

device.
Installing a Installing a decorative-mount repeater is arelatively simple process. To install
Decorative-Mount this type of repeater, follow the steps below.
Repeater
Step Action

1 Remove the existing photo-€el ectric sensor from the decorative
lamppost. Be sure to note the orientation of sensor window (this typi-
cally faces north).

NOTE Theexisting sensor isno longer needed. The decorative repeater
has a built-in photo-electric sensor.

2 Slidetherubber seal over the base of the repeater, as shown below. The
seal should lay just below the photo-electric sensor window on the
repeater.

L— Photo-electric Rubber seal —
sensor window
32 Repeater Installation Guide
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Installing Decorative-Mount Repeaters

Step Action

3

If necessary, rotate the socket so that the photo-electric sensor window
will be oriented properly (typically facing north) when the repeater is
installed. If aphoto-electric sensor was previoudy installed, the socket
should aready be oriented properly.

Attach the repeater to the top of the lamppost. Be sure to aign the
prongs on the repeater with the corresponding sockets on the lamppost.

NOTE To ensure aproper connection and atight seal, considerable
downward pressure may be necessary to attach the repeater and rotate
it into position.

Slide the rubber seal down to the top of the lamppost.

Verify that atight seal around the entire repeater has been created; this
will keep water from intruding into the repeater and top of the
lamppost.

Chapter 3 - Eight-Channel Repeater Installation
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Installing Decorative-Mount Repeaters

2 Slidetherubber seal over the base of the repeater, as shown below. The
seal should lay just below the photo-electric sensor window on the
repeater.

L— Photo-electric Rubber seal —
sensor window
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Installing Decorative-Mount Repeaters

4  Attach the repeater to the top of the lamppost. Be sure to aign the
prongs on the repeater with the corresponding sockets on the lamppost.

NOTE To ensure aproper connection and atight seal, considerable
downward pressure may be necessary to attach the repeater and rotate
it into position.

5  Slide the rubber seal down to the top of the lamppost.

Verify that atight seal around the entire repeater has been created; this
will keep water from intruding into the repeater and top of the
lamppost.

Step Action
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Installing Decorative-Mount Repeaters

Step Action

6  When you have finished, your lamppost should look similar to the
example below.
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